integml SIcHT FORAN, @ Sanda
Laboratories
Simple Channel Setup
Dilow-FM-CEC application

Chris Chartrand
Craig Jones
Jessica Nguyen

5/1/2024

Current energy converter modeling

Not for Third-Party Distribution



Develop Simple channel with turbines

Module will highlight the following:
> Develop Grid in RGF-Grid

> Apply bathymetry and boundary conditions

Simple Discharge and water levels

> Set up output locations

> Develop Turbine inputs

> Execute model

> View Results
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GUI Walkthrough
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o — st m- Gls turbine_test_straight_channel - Delft3D FM Suite 2024.01 HMWQ
Home View Map Spatial Operations &
44 A North Amrow 51 € Zoom Previcus |13 Map Coordinate System &, ™ [ show o s j Load
& [E]Legend K @ 2 ZoomMext 97 Export As Image LN & ® A @ @ Add Obsenvation Point ( 3 S t' l t' b
ks @ m @ Query Features & Query Time Series ~ ® & Find Grid Cell pa la ac lons menu ar
FM Re. Tools Edit Grid Profile Area Water Quality
Project v & X | |@ FlowfM X | FlowPM (FM model settings) | = Map - x
2] G |F3 | (2 | &[] Use focused layer
=773 turbine_test_straight_channel p
& F . . 9 . FlowFM
g 2) Map showing grid, and features ID’ed on right -> e
& Gid b oundary Conditions
B Bed Level [ Boundaries
45 Time Frame [[] Sources and Sinks
1) t & Processes [ Laterals
IVI 14 Initial Condtions . . .
enu 0 [ Boundary Conditions [ Estimated Grid-snapped features
/ & Discharge Obsenvation points (snapped)
aCCeSS GUI S B Water_level Thin dams (snapped)
(7 Physical Parameters Fixed weirs (snapped)
features | Sources and Sinks Dry points (snapped)
i Laterals
2] Numerical Parameters 2 Dry areas (snapped)
Q
i3 Output Parameters 6 Enclosure (snapped)
[ Output Pumps (snapped)
Structures (snapped)
Observation cross sections (snapped)
Sources and sinks (snapped)
Properties - x Boundaries (snapped)
o Water level boundary points
ischarge / velocity boundary points
=]
P nstructured Grid
[ Initial Water Level
[ Roughness
b [ Viscosity
b [ Diffusivity
m 50 100 150 200 v Initial velocity X
b Initial velocity ¥
Messages MR i [ Bed Level
Project turbine_test_straight_channel saved 2024-04-15 1432:51602 [~
] ig
During impart of data from the External Forcing file the following warnings were reported: 2024-04-15 14:32:46.608
5] - Mo spatial operations of type Import, Add or Value found for spatiall varying property sand_channel SedConc. Remember to interpolate them to generate the xyz fle. Otherise the model might not n .
@ saving project turbine_test_straight_channel as CAL _channel_ . test_straight_channel dsproj 2024-04-15 14:32:43916 4) Map Dlsplay
@ Vall cock Flowei 2024-04-15 14:29:42.106
Stort time: 15-Apr-2024 1422:26. L
@ WModel “FlowFM" has finished in 144 steps. 2024-04-15 14:29:42.104 ay ers
@ Path used: C1\Program Files\Deltares\Defft3D FM Suite 2024.01 HMWGAplugins\DeltaShell.Di \Program Files\Dehares\Delft3D FM Suite 2024.01 HMWQ\plugins\DettaShell.C 2024-04-15 14:22:26.152
@ Running dimr in ; C:\Users\smowilliams74\AppData\Local\Temp\DeltaShell_Warking Directory\FlowFM 2024-04-15 14:22:26.152
9 e P o n/
During import of data from the Extemal Forcing file the following warnings were reported: 2024-04-15 14:22:23.689 [~ | Map | Operations | Chart
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5) Messages indicating success, warning, and
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Tabs and menus

Not for Third-Party Distribution

The General tab opens access to the tabs seen across the top. These follow

similar inputs to the structured Delft3D-Flow.

Project - 0 x ” FlowFM FlowFM (FM model settings) X

c|

E}--% turbine_test_straight_channel
9 = oW el

- @@ Bed Level

b #b) Time Frame

[ ﬁ Processes

(- [ig Initial Conditions

&

{ Boundary Conditions
ﬁ Discharge

L] Water_level
F#- =] Physical Parameters
>_w Sources and Sinks

-| g Laterals
Mumerical Parameters

& [t Output Parameters
G- [ Output

integral
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General | Time Frame | Processes | Initial Conditions | Physical Parameters | Wind | Numerical Parameters | Output Parameters | Advanced | Miscellaneous | 3D Layers

(#) Global Position
Angle of latitude

Angle of lengitude

0] [deg]
0] [deg]

Coordinate system

<empty]




Building Basic Channel
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Start a new model

>

integral

Start a new

l“ Home Wiew
flexible mesh fy %o + S = Newltem~ ¢ Run Al
O Copy lj *3 New Folder Run Current
mOdel das ShOWH Paste X D ’ Mew |Import Export 7 r
. elete | Niiadel = - El Run Script
on the right |
Clipboard 1D / 2D / 3D Integrated Models
Project Empty Integrated 20-30 Integrated
* Madel * Maodel
% Projectl 1D /2D / 3D Standalone Models
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* Water Quality Model

Flow Flexible hMesh

Madel
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::{:} = oo {7] Show Log
- = oo

) 'ﬂ' [ License
Find Open Start

Manual = Screen © About

* Wawves Model
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Project * 0 X e

Grid Development T

=+ E turbine_test_straight_channel
= [ FlowFM
i 2] General

> Double click on Grid to open [ Are
RGF Grid.

b ﬁ Processes

B8 RGFGRID 7. 03.00.77422 - [--unnamed-- 1
File Edit Operations View Coordinate System Settings Help

EEEY HEFE EEF RN E IR

> New window will appear

> Program is used to build
rectilinear, curvilinear, and
unstructured grids.

integral i) Netoma

Laboratories




Generate a simple Rectangular Grid

>

integral

Simple grids can be
generated by
defining the
number and size of
cells.
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[E) RGFGRID 7.03.00.77422 - [--unname d--]

Create

Convert Grid

@ Change Splines into Grid
Grow Grid from Boundaries

Grow Grid from Splines

I Create Rectangular or Circular Grid...

Regular Grid Coarseness
Undo Grid Operation
Irregular Grid Coarseness
Orthogonalise Grid

Flip Edges

Grid

Samples

Attach Grids at DD Boundaries
Compile DD Boundaries

File Edit | Operations View Coordinate System Settings Help

Domail 5] —
| @ @ Domain ®HE
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8 Create Rectangular or Circular Grid... ? x

Mumber of Gridcells in M-Direction |15CI

Mumber of Grid cells in N-Direction Ilﬂ

Delta % [m] |10

Delta ¥ [m] |10

Origin ¥ [m] [ 100

Qrigin ' [m] [ 100

Rotation left [deq] IU

Radius of M-Curvature [m] IU

Iniform M-Fraction [-] |1

Maximum Size [ Delta X [] [1

Lniform M-Fraction [-] |1

Maximum Size / Delta ¥ [] 1 1
Ok, Cancel F.
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Convert from a structured to unstructured grid

> Basic Structured Grid is
developed.

>

> Convert from Regular to Irregular

* **Key step for flexible mesh grid.

* Grid links should change from
dark to light blue!

> File-> Save Project and exit

Laboratories
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laexxpilodocEeom x|y rERAENLER

T
”é@ Domain

File Edit | Operations View Coordinate System Settings Help
i B B

58 RGFGRID 7.02.00.77422 - C:\Users\smcwilliams7M\AppData\Local\ Temp\jSfdnyin\rgfgrid.d:

13
3
L3
3

@ Change Splines into Grid
Grow Grid from Boundaries
Grow Grid from Splines
Grow Grid from Polygons

Create Rectangular or Circular Grid...

Regular Grid Coarseness
Undo Grid Operation
Irregular Grid Coarseness
Orthogonalise Grid

Flip Edges

Grid

Samples

Irregular to Regular

Attach Grids at DD Boundaries
Compile DD Boundaries
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Grid will appear in Map view of GUI

Home View Map Spatial Operations
B 4 A Northamow [y £ € Zoom Previous |37 Map Coordinate System &, % [ Srow Profile gy ® % 00 Add Load
U < Legend & @ 3 ZoomNext 7 Export As Image e, % ® A ™M @ Add Observation Point
[ = " @ @ Query Features Query Time Series Y @ M A - Find Grid Cell
FMRe..  Decorations Toals Edit Grid Profile Area Water Quality
Project - 0 x| @ Flowrh X | =h
@ [
=i Project]
£+ [l FlowFM
General
i [ Area
a2
@8 BcdLevel
4 Time Frame
o Processes

i [ig Initizl Conditions

[ Boundary Conditions
G- (= Physical Parameters
[ Sources and Sinks
| Laterals

] Numerical Parameters
[ Output Parameters

G- [ Output

Properties - o X

=

—-— e
m 50 100 150 200
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Bathymetry

> Add bathy to the grid

> Select the bed level layer in
the spatial operations menu

> This menu allows you apply
spatial data to grid from an
xyz file or assign bulk values
across regions.

Laboratories
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Bathymetry is applied in the GIS
Spatial Operations Menu!!!

b *I:I < R~ GIS
“ Home View Map Spatial Operations
= v : Polygon | mpaor
=| e L L {= £ Crop
Initial Water Level o NS = Lrop
Legend . Merge P
Roughness mm FOIntE Operations < LDelste
ECOrd... Viscosity Add
Project Diffusivity < | @ FlowrM x
on Bed Level
El--% Project
=+ [ FlowFM
i 2] General
[!,—' Area
e
- @@ Bed Level

b 45 Time Frame




Bathymetry Ctd.

integml

Draw a[polygon)
around the grid-

Select Set

Enter -10 to set a
depth of 10 m
everywhere
inside the

polygon

Depths are
relative and are
negative. i.e. you
can relate depths
to a datum like
NAVD88 or MSL
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sha W=

Home View

Map.
S =
£, Lin

GIS

Spatial Operations

.
< & Delete W Gradient 5"

) Impar
i+ Crop

B SetValue 7

Interpolation operation

Value

Paintwise operation

Please specify the operation parameters

[0 |

|Ovemrie 4 |

0K ||Cant:el|

~  mmCopytosamples g Copy to spatial data

T Merge spatial data

Set Label
§ Overwrite Label
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Legend m  Merg
Decora... Edit e
Project v 1 x || @ FlowfM X |
cal
£+ Project]
- [l FlowFm
[z General
[ Area
ea{Gd
B9 Bed Level
45 Time Frame
o Processes

- (14 Initial Conditions
[ Boundary Conditions
i [# Physical Parameters
| Sources and Sinks
L Laterals
[2] Numerical Parameters

53 Output Parameters
- [ Output

— e
m 50 100 150 200




Bathymetry Application Success

Home View Map
& A North Arrow @:};’ € Zoom Previous [1) Map Coordinate System &, "% [ Show Profile g ® "%,
Bkt @ 3 Foom Mext
& = @) Query Features [ Query Time Series

Spatial Operations

- 0 x| |@ FlowfM x

) Export As Image

=7 Project

[ FlowFM

- 2 General
o Area

- B3 ri.al

8 Bed Level

Legend
b FlowFM
p Bed Level
b Setvalue 1
output

-10
==

- 45 Time Frame
& Processes
- |4 Initial Conditions
Boundary Conditions
| Physical Parameters
[ Sources and Sinks
- Laterals
Mumerical Parameters
- ;2 Qutput Parameters
- [ Output

Properties v o X

51|

L\
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s @ A Find

m

50

100 150 200
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Area
Boundary Conditions
Boundaries

Sources and Sinks

Laterals

[] estimated Grid-snapped features
Unstructured Grid

[ Initial Water Level

[] Roughness

[ viscosity

[ piffusivity

[ Initial velocity X

Bed Level

13



Boundary Conditions

> Multiple boundary types
can be applied.

> The 2D flow boundary
(highlighted) is applies
across grid cells for water
level, discharge, or velocity

> Can be defined by drawing
lines where boundaries are
desired

°* Boundaries can have
multiple points

*  Double click to end

integral i) Netoma
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FM Re...

Morth Arrow IEI C1 € Zoom Previous @ Map Coordinate System
| Legend x: & 3 Zoom Next 9 Export As Image

4, Scle s s @ Query Features Query Time Series

Cecorations Tools

“ Home WVie
m JE N\ North Arrow [
U & =l Legend | 1
K Add a (2D) flow I:u::uundary:

FM Re... Decorations

P
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Boundary Conditions Ctd.

> Draw BCs along edges at left and right extents

* They should be close but the program will snap them into place along grid edge

> Two entries in the left menu will appear (BoundaryO1 and Boundary02)

12 grerreruy

[]--w Area
- 03 Grid
- (@@ Bed Level

~ @ T P Eventual Flow

T i o Discharge Direction Water Level

[ [+ Boundary Conditions
>E Boundary(1

w Boundary02 K ‘N .
[]--ﬁ Physical Parameters F) ‘_" -

-y Sources and Sinks : mmmm . |
- |_ga Laterals e FHHH
- [z Murnerical Pararmeters . aaas

B Output Parameters

. .
[ [y Output . 1
. mmm [
. mmmLan mmmnn
.
a

in[egml A Netona _
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Discharge Boundary ( on Left).

> Open the first BC

> Select Discharge
from menu and
press the +

> Adischarge
boundary will
provide flow across
multiple points

Sandia
National
Laboratories
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FlowFM F
@

lowFM (FM model settings) Discharge (Boundary co)

Boundary Condition

Flow

o

Water level ~

Water level
Velocity

Riemann invariant
Meumann gradient
Discharge

Not for Third-Party Distribution

@ FlowFM FlowFM (FM mode! settings) Discharge (Boundary conditions) X
Boundary Condition Locati
Fl ~ A Geom
o Descripticn: Discharge
Forcing Type: Time Series i
Time zone: 00:00:00
Vertical interpolation type:
Reflection parameter:
Thatcher-Harleman time lag: 00:00:00
v
Discharge ~|dE| ¢ >
ﬂ Generate series... | Import from files...
| Clipboard import | Csvimport EL Csv export
| Time [-] | Discharge [m3/s] |
#| |
| 44| « |Record 0 ofo » | ||+ |=| 2|« ] i
16



Not for Third-Party Distribution

LIscnarge i =" < >
Discharge Boundary (on left)[; B
T [ Clipboard impert 2, Csvimport Csv export
. . Time [-] Discharge [m3/s]
> Atimeseries can be manually : g
developed or imported from a
file
Generate time series.. x 85 Choose support points - O X
> Generate a timeseries for 12 ® Garerserew e
hours with 4 hour intervals. N Oz
Start [¢15202¢ @~ | iz0000AM [2]] O Inactive suppart paints
End [ 411572024 @~ | [120000PM ] O stame e
Timestep [0 [ 0 [P E vl:
> Select all support points to o - _ —

apply across entire boundary

Laboratories 17
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Discharge BC applied
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> After adding the timeseries you can assign values for discharge.

> 1000 m”3/s equalsal m/sveland 2000 = 2 m/s vel in the channel

il Generate series...

Import from files...

E Export to files... 2 Combined BC view

ipboard import ,| v import sv export
2 Clipboard import 5| Cevimport [EL Csv exp

Time [-]

Discharge [m3/s]

| | —— Discharge [m3!s]|

¥ | 2024/04/15 00:00:00 % 1000
2024/04f15 04:00:00 1000
2024/04f15 08:00:00 2000
2024/04/15 12:00:00 2000

| # | 4| Record 1o0f 4 >|»|»||+|—|A|v|x|1|

2000 4
1900 |-
1800 4
1700 |-
1600 |-
1500 4
1400 -
1300 |-
1200 -
1100 |-
1000 -

00:00 01:00 02:00 ©O3:00 O04:00 05:00 O06:00 O7:00 O08:00 05:00 10:00 11:00 12:00

j (2024-04-15) Time [-]

i1
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Water Level BC

> Repeat the process on the downstream BC but select water level instead of
discharge

> Set the water level to O for the duration of the model run.

ﬂ Generate series... | Import from files... | & Export to files... oy Combined BC view

[, Clipboard import [, Csv import Csv export

Time [-] WaterLevel [m] — WaterLevel [m]
¥ | 2024/04/15 00:00:00 = 0
2024/04/15 12:00:00 1]
#*
u]

00:00 01:00 02:00 03:00 04:00 05:00 .DG:DD 07:00 08:00 0%:00 10:00 11:00 12:00
4|4 | 4| Record 10f2 >|»|»||+|—|A|«|x|<| j (2024-04-15) Time [-]

integral i) Netoms .
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Model Settings

A



Time Frame

> Set reference dates
and start and stop

> Solver is dynamic and
will select a timestep at
each computation
based on Courant
threshold to maintain
stability

* This means the
model run-time can
be variable and slow
down/speed up

Sandia

National
Laboratories
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Project

ol

v 0 X ||@ FlowF

= E turbine_test_straight_channel_n
= [l FlowFM

EEI--[\'_,- Area

- B Grid

- [ Bed Level

-4 Time Frame

ﬁ Processes

[ i Initial Conditions
-5 Boundary Conditions

EE}--_:}‘ Physical Parameters
|y Seurces and Sinks

- g Laterals

- ] Mumerical Parameters
- |zgh Cutput Parameters
- [ Output

Not for Third-Party Distribution

Discharge (Boundary conditions) FlowFM (FM model <

Generapmcesses Initial Conditions | Physical Parameters | Wi

® Time Frame

Max Courant nr 0.7 [-]
Reference date 2024-04-15 E~]
Time zone 0/ [-]
User time step | 04 00:05: 00,000 |
Nodal update interval | 0d 05:00: 00,000 |
Max. time step 30| [s]
Initial time step 1) [5]
Start datetime 2024-04-15 00:00:00

Stop datetime 2024-04-15120000 & |

21
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Menu Options

> We can skip Processes, Initial Conditions, Physical parameters, and
Numerical Parameters for now.

> However, each have key parameters for setting up sediment transport,
global roughness, and initial water levels.

integral i) Netoma
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Output Parameters

General | Time Frame | Processes | Initial Conditions | Physical Parameters | Wind | Numerical Parameters| Output Parameters | Advanced | Miscellaneous | 3D Lat

@ History

@ Map

> Outputs are in NetCDF Write His file Write Map file
f t His output Interval | 0d 00:05:00.000 Map cutput interval | 0d 00: 20:00.000
Orma Specify His output start time O Specify Map cutput start time O

integral

His files are point or
cross section locations

His output start time
Speaify His output stop time

His gutput stop time

2001-01-01 00:00:00

2001-01-02 00:00:00

Map output start time
Specify Map cutput stop time

Map cutput stop time

2001-01-01 00:00:00

2001-01-02 00:00:00

Write mass balance totals Write water levels of pravious time
1 t
(We]_]_ def]_ne ]_ater) Write sources-sinks statistics sep
. Write water levels
Write general structure parameters . 3 .
Write velocity component of previous

Map files are across
entire grid

Map files can get large
so be mindful of what
you are outputting

Sandia
rI‘ National

Laboratories

Write dam parameters
Write pump parameters
Write gate parameters
Write weir parameters
Write k, eps and vicww
Write wind velocities
Write precipitation
Write temperature
Write heat fluxes
Write salinity

Write density

Write water level
Write water depth
Write velocity vectors

Write upward velocity

ODNDOMNRKEEEMRMNRERERRR R R R

time step

Write velocity component

Write cell-center velocity vectors
Write upward velocity component
Write flow density

‘Write horizontal viscosity

Write horizontal diffusivity

Write flow flux

Write the number of times a cell was
Courant limiting

‘Write the shear stress
Write the Chezy roughness
Write vieww k and eps
Write wind velocities

Specific Map output times

NERREDOEE

HERER

[s]

23
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> Set the number of Sigma layers to 10. The turbine module will interact only
with the layers it overlaps.

B FlowFM Discharge (Boundary conditions) FlowFM (FM model settings) X

General | Time Frame | Processes | Initial Conditions | Physical Parameters | Wind | Numerical Parameters | Output Parameters | Advanced | Miscellaneous | 3D Layers
@La}rers

Komx

Layer type Sigma

integral i) Netoma
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Observation points —
o ik ® L C

Zoom Previous [17] Map Coordinate System A, % [ show profie gy @ X, Add Load -~
ZoomMNext 77 Export As Image o, i ® A M @ Add Observation Point - |

> Add observation St et e T O
points to oo e s A & :
determine where -
you want to see
history file outputs

Area

> We can use these
as proxies for
turbine locations
later.

- e
m 50 100 150 200

Laboratories
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Model is now set up to run without turbines

> The steps outlined above get us to a base model with relevant components
* Unstructured grid
° Basic bathymetry
° Boundary conditions

> Save model in File-> Save as

* Select a save location and check to make sure it created
— .proj file

— Project folder and a subfolder called FlowFM and in that a subfolder called input

integral ) Natons
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Turbine Application Procedures

> Requires two descriptor files for turbines
° Curves.trb
° Turbines.ini
> Copies should be provided in documentation
> Requires modification of .mdu file
* .mdu file is master definition file for dflow-fm model runs

° Found in project folder

Sandia

|[][Qg[d| rll National
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Modify .mdu file with turbine reference files

> The .mdu file is the master

definition file for unstructured
. 230  WaterdepthClasses
E;r1(1s 231 ClassMapInterval
232  StatsInterval

> Open the file from the input folder 23° Timingsinterval

. . 234  Richardsononoutput
in a text editor and copy 235
236 [Turbines]
237 TurbineFile
238 CurvesFile

turbines.ini
curves.trb

[Turbines]

TurbineFile = turbines.ini

CurvesFile = curves.trb

> The two reference files contain the
description of a basic set of
i"[egm turbines and a generic rating
curve

28
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Turbine files

> Copy Turbines.ini and curves.trb into input directory

HTurbineFileInFurmatiDn]

FileVersion = 81.86
[General]
CurvesFil = #curves.trb e 'Turbine Type 1 '
[Turbine] parameter 'velocity o ' un?t "[m/s]"
parameter 'thrust coefficient ' unit '[ - 17
Name = #Turbinel parameter 'power coefficient ' unit '[ - 1"
Turbtype =1 0.0 0.84  0.37
Width =5 0.5 0.84 0.37
Height =5 1.0 0.84 0.37
Orientation =6
VertPos = #fixed#
Axislevel = -5
ThrustCurve = #Turbine Type 1#
PowerCurve = #Turbine Type 1#
NDiaDistdVel = 8.8
TurbineModel = 1
' Sandia
integral (i) i
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Reload model

> Reloading the model will make sure the modification are included

> You can check that those files were included in the GUI in the
Miscellaneous tab

” FlowFh FlowFM (FM model settings) X

General | Time Frame | Processes | Initial Conditions | Physical Parameters | Wind | Numerical Parameters | Output Parameters | Advanced | Miscellanecus | 3D Layers

® ®

Time step type full impl. step reduce v TurbineFile turbines.ini

Turbulence model k-eps - CurvesFile curves.trb

horizontally explicit and
vertically implicit

Turbulence advection

Water level threshold 0| [m]
Welocity threshold 0| [m/s]
Dry cell threshold 0.0001]| [m]
XLS output interval 0d 00:00: 00.000 |

Laboratories 30
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Run The Model
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Check the Model e | T

El- % turbine_test_straight_channel_n © Sﬂd'm'ﬂhﬁhﬂ
= =Y (3 Coordinate System

Wt Merge with:
> We're ready to run the model - ¥

Turn into or Move to Integrated Model  »
Open With...

Run Model

Stop Model

[+

> A good check prior to Clear Model Output
executing is to “validate” first s boe
. opy
to make sure all settings are B ot Detee
lnput Rename
. . - __ Import...
> Right Click on FlowFM and Export..
select validate Expand Al
Collapse All
- :: File Tree...
Properties SEt.tings
WaterFlo El Validate...
inteeral (Al Nt SN
eg Laboratories 32



Results of Validation

> All check —boxes should be green

> Some may show as red if
something is not properly set up
and it will tell you what those are.

°* Common issues may be
inconsistent timing of start/stop
and boundary conditions

> Warnings with ! May also appear
and you can select the item to
evaluate why

integral i) Netoma

Laboratories

Not for Third-Party Distribution

& FlowFm FlowFM (FM model settings) (1) FlowFM X

(&1 FlowFM (Water Flow FM Model)
(L) SedimentThickness
i Coordinate System
() Domain
() Bathymeiry
(i Physical Processes
(L) Water flow FM model wind forcing
(L) WaterFlow FM model definition
(Z) Water flow FM model boundary conditions
(L) Struchures
(L) Inputrestart state
(L) Restart time range setiings
(Z) Enclosure

33



Run the model

> 2 Ways to execute
> Right Click FlowFM and select run

E}--% turbine_test_straight_channel_n & CAIMENT Meme:

) FiowFM (& Coordinate Syste:
Merge with:
B Turn into or Move to Integrated Model  »

= )
| B RunModel
-

b+ < Clear Model Qutput

Cut
.| 53 Copy
>< Delete

Rename

[ Import...
Export...
Expand All

Collapse All
<

CZ2 File Tree...

Properties Settings
WaterF Validate...

Sandia
r“ National
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“ Home View Map
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> In Home Menu select Run Current

Spatial Operations DIMR.

'Y Run All _-;{:}

ﬁ Cut +‘£I' c)\j @‘J =1 Mew ltem =
D Copy *5 Mew Folder

Paste Mew Import Export Find
2 Delete | pModal- - . Ll Run Script
Clipboard Add Run Editing
Project ~ 0 x| @ FlowFM X | FlowFM (FM model setting
CH
[ &m,

Y



Model running

integral

If model is run from the GUI a
box will appear showing
progress

NOTE: This is not the only
way to run these models

Models can be run with bash
scripts, on linux, or other
means.

i1
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1@&@@&@@::—

Please wait while processing..

.t FlowFM [Executing)
Progress: 00:00:27 (34.17%)

Cancel all activities
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Success!!

> Model run was successful and results are displayed in GUI.

> Save model and results will be saved to an output folder in same location as
the input folder

integral i) Netoma
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Not for Third-Party Distribution

Influence of Turbines can be seen

Project ~ B X |[@ FlowPM X | FlowFM (FM model settings) | (1) FlowFM 5 |Map X
& (| & | €| [ Use focused layer
lowFM

Arez

Boundary Conditions
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Observation Point results

> You can right click on an observation point to query a timeseries

Not for Third-Party Distribution

* Turbine data is not included in these but velocity, water levels, etc. are

available

& Select

— Delete selection

/ﬁi | ﬂ CQuery time series I

_!L Export map as image

CF ]
o w ZLoomtoextents

eyl ﬁ;“sﬁ T

Select Time Dependent Spatial Data

Available tems
Owner Spatial Data
3 FlowFM water level (waterdevel)
FlowFM flow element center depth-averaged velocity vector, x-component (depth-averag
FlowFM flow element center depth-averaged velocity vector, y-component (depth-averag
FlowFM Mean bottom shear stress vector, x-component fausx)
FlowFM Mean bottom shear stress vector, y-component fausy)
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Water level example

. . Q FlowFM | FlowFM (FM model settings) |Q) FlowFM | water level (waterlevel) at ObservationPoint02 X H
> Tlmeserle S are B Ciphosrd import ) Covimport B Cv export
Time [yyyy/MM/dd HH:mm:ss] | Observ...oint02: water level ... [m] o
: | 2024/04/15 00:00:00 o Observ...0int02: water level ... [m]l
aval a e tO S e e 2024/04/15 00:05:00 0242176188531
2024/04/15 00:10:00 0,121976381421
2024/04/15 00: 15:00 0.00443589609978 0.24
2024/04/15 00:20:00 0.0704062217452 0.22
2024/04/15 00:25:00 0102068465556 0.2
2024/04/15 00:30:00 0.0365558249023
2024/04/15 00:35:00 0.00680038858414 0.18
2024/04/15 00:40:00 -0.0654318067495 016
2024/04/15 00:45:00 0.0461559167715
N h . b . l . . 2024/04/15 00:50:00 0.027813214824 014
) Ote t e lnsta ]_ ]_ty ]_n 2024/04/15 00:55:00 -0.0265040451373 F 012
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* * 2024/04/15 01:05:00 -0.0363655566262 g
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may indicate the T o i il
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2024/04/15 01:45:00 -0.0148476821842 I | T —
. 2024/04/15 01:50:00 0,00303516313001 -0.04
tl m e 2024/04/15 01:55:00 -0.0003974482546.35 0.08 !
2024/04/15 02:00:00 -0.0149871561773,
2024/04/15 02:05:00 0.00440771293352. -0.08
2024/04/15 02:10:00 0.00577283056252 -0
2024/04/15 02:15:00 0.01223452466 1 o2
2024/04/1502:20:00 0.00356185922748
2024/04/15 02:25:00 -0.0088519159108 00:00:00.000 02:00:00.000 04:00:00.000 06:00:00.000 08:00:00.000 10:00:00.000 12:00:00.000
2024/04/15 02:30:00 0.00924324140562. JJ Time [yyyy/MM/dd HH:mm:ss]
Wi[# | 4| Record10f145 | k|| +|—| || %[ 4 (2024-04-15)
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Alternate Visualization methods

> The GUI is limited to only displaying depth-averaged results

> To show layers programs like Quickplot, or processing scripts in matlab or
python are required

> Model outputs are in NETCDF and turbine power is recorded in a
Turbine_Power.dat file that can be easily manipulated.

Q{r FlowFM.dia A017/2024 8:02 PM DIA File 80 KB
Qf’ FlowFM_his.nc A017/2024 8:02 PM MC File 462 KB
[ FlowFM_map.nc 4/17/2024 8:02 PM M File 35,233 KB
2 Turbine_Power.dat 471772024 8:02 PM DAT 6,817 KB
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Power output for each turbine

Not for Third-Party Distribution

> Power from each turbine at each timestep is recorded in the
Turbine Power.dat file

Turb#

[

WM WNEF WK W Wk E Wl e W
LT« ST« S BT S 0 [ B OV I X o O e = B = = = I e ]

inteoral

.0000000000000000
.0000000000000000
.0000000000000000
.0000000000000000
.0000000000000000
.0000000000000000
.0989010989010850
.09692010969010990
.0989010989010850
.3041474654377883 0.
.3041474654377883 0.
.3041474654377883
.62724014336€91757 0.
.6272401433691757 0.
.62724014336€91757
.0600477897252092 0.
.0800477897252092 0.
.0600477897252092
-6742096935645323 0.
.6742096935645323 0.
-6742096935645323

Time

oo o000 oo
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Thrust

.0000000000000000E+0D
.0000000000000000E+00
.0000000000000000E+0D
.0000000000000000E+00
.0000000000000000E+0D
.0000000000000000E+00
.9929573077815315E-21
.704470969642879%E-81
0.4826488871886338E-150

7288121352469331E-17
5330134699143993E-72

0.46068265053531002E-135

107527886%301762E-13
3161212602897435E-64

0.1806895247951000E-122

5524133399341607E-11
3885944572465936E-57

0.7446995057350654E-111

1219%08625167943E-08
1229536017357804E-50

0.8098135055142526E-100

Power

0.0000000000000000E+00
0.0000000000000000E+00
0.0000000000000000E+00
0.
0
0
0

0000000000000000E+00

.0000000000000000E+0O
.0000000000000000E+00
.1345004238924315E-33
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0.
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0.
0.
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.0000000000000000E+00
.0000000000000000E+0D0O
.0000000000000000E+00
.0000000000000000E+0D0O
.0000000000000000E+00
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COoO000C0000000000000000
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-2500000000000000E+02
.2500000000000000E+02
-2500000000000000E+02
.2500000000000000E+02
-2500000000000000E+02
.2500000000000000E+02
-2500000000000000E+02
.2500000000000000E+02
-2500000000000000E+02
.2500000000000000E+02
-2500000000000000E+02
.2500000000000000E+02
-2500000000000000E+02
.2500000000000000E+02
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-2500000000000000E+02
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-2500000000000000E+02
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Cct

.5400000000000000E+00
.8400000000000000E4+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
.5400000000000000E+00
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cp

.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
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.3700000000000000E+00
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.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
.3700000000000000E+00
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Next Steps

> Try to manipulate the inputs
° Boundary condition discharge rate/ water level
* Turbine parameters-turbines.ini
* Number of turbines —turbines.ini

* Modify power curve — curves.trb

integral i) Netoma

Laboratories 42




	Slide Number 1
	Develop Simple channel with turbines
	GUI Walkthrough
	Tabs and menus
	Building Basic Channel
	Start a new model�
	Grid Development
	Generate a simple Rectangular Grid
	Convert from a structured to unstructured grid
	Grid will appear in Map view of GUI 
	Bathymetry
	Bathymetry Ctd.
	Bathymetry  Application Success
	Boundary Conditions 
	Boundary Conditions Ctd. 
	Discharge  Boundary ( on Left).
	Discharge Boundary (on left)
	Discharge BC applied 
	Water Level BC
	Model Settings 
	Time Frame
	Menu Options 
	Output Parameters
	3D Layers
	Observation points
	Model is now set up to run without turbines
	Turbine Application Procedures
	Modify .mdu file with turbine reference files
	Turbine files
	Reload model	
	Run The Model 
	Check the Model
	Results of Validation
	Run the model 
	Model running 
	Success!! 
	Influence of Turbines can be seen 
	Observation Point results
	Water level example 
	Alternate Visualization methods
	Power output for each turbine
	Next Steps

